Sign Calculator
User’s Guide

By Brian Bieber – IT Division

NORTH DAKOTA DEPARTMENT OF TRANSPORTATION
BISMARCK, NORTH DAKOTA

Website: https://www.dot.nd.gov/

INTERIM DIRECTOR
Grant Levi, P.E.

PROJECT DEVELOPMENT DIRECTOR
Bob Fode, P.E.

Principal Author: Travis Cork
January 2013
# Table of Contents

Introduction .......................................................................................................................... 1
Installation ............................................................................................................................. 2
  System Requirements ......................................................................................................... 2
  Local Installation ............................................................................................................... 2
  Server Installation ........................................................................................................... 2
Launching the Database ........................................................................................................ 4
  Getting Started .................................................................................................................. 4
  Startup Screen .................................................................................................................... 4
Pipe/W-Shape Calculator ...................................................................................................... 6
  Data Input Screen .............................................................................................................. 6
  Example .............................................................................................................................. 16
  Project Book ...................................................................................................................... 20
    Parts of the Project Book ............................................................................................... 20
    Printing the Project Book ............................................................................................. 21
Perforated Tube Calculator ................................................................................................. 24
  Data Input Screen .............................................................................................................. 24
  Examples ........................................................................................................................... 34
    Example #1 – Two Lane Two-Way Roadway on a Curve ............................................ 34
    Example #2 – Two Lane Two-Way Roadway on a Tangent ........................................ 37
    Example #3 – Four Lane Divided Highway on a Curve ............................................. 40
  Project Book ..................................................................................................................... 43
    Parts of the Project Book ............................................................................................... 43
    Printing the Project Book ............................................................................................. 44
Exporting RTF Files ............................................................................................................. 47
  Creating the RTF File ........................................................................................................ 47
  Bringing the RTF File into MicroStation ......................................................................... 48
  Editing Project Book Data in MicroStation .................................................................... 49
Import/Export Project Tables ............................................................................................... 50
  Updating the Sign Calculator Program ........................................................................... 50
Support ................................................................................................................................ 52
  Internet ............................................................................................................................. 52
  E-mail ............................................................................................................................... 52
Appendix A – Typical Ditch Sections .................................................................................. 53
Appendix B – Order of Calculations for Perforated Tube .................................................. 57
Appendix C – Standards Maintenance ................................................................................ 58
  Startup Screen ................................................................................................................... 58
  Pipe Sizes ........................................................................................................................... 60
  W-Shape Sizes .................................................................................................................. 61
  Standard Assemblies ......................................................................................................... 62
  Perforated Tube Sizes ...................................................................................................... 65
  Perforated Tube Sequence ............................................................................................... 68
  Variable Sign Width ......................................................................................................... 69
  Variable Sign Height ....................................................................................................... 71
  Updating the Standards Tables ....................................................................................... 72
# Table of Contents

Glossary ........................................................................................................................................ 74
Index ........................................................................................................................................... 79
Table of Figures

Figure 1 – Sign Calculator Startup Screen ................................................................. 4
Figure 2 – Pipe/W-Shape Calculator Data Input Screen ........................................... 6
Figure 3 – Pipe/W-Shape Input Sheet ...................................................................... 8
Figure 4 – Pipe/W-Shape Notes Report .................................................................. 8
Figure 5 – Edit Group Description Dialog Box ........................................................ 9
Figure 6 – Sign Types for Pipe/W-Shape Supports .................................................. 10
Figure 7 – Design Area Example ........................................................................... 11
Figure 8 – Graded Width Examples for Pipe/W-Shape Supports ............................ 13
Figure 9 – Pipe/W-Shape Example Cross Section .................................................. 16
Figure 10 – Pipe/W Shape Example Data Input Screen ......................................... 19
Figure 11 – Pipe/W Shape Project Book ................................................................. 20
Figure 12 – Pipe/W-Shape Project Book Margins Setup ........................................ 22
Figure 13 – Pipe/W-Shape Project Book Page Setup .............................................. 22
Figure 14 – Pipe/W-Shape Project Book Columns Setup ....................................... 22
Figure 15 – Perforated Tube Calculator Data Input Screen .................................... 24
Figure 16 – Perforated Tube Input Sheet ................................................................. 26
Figure 17 – Perforated Tube Notes Report ............................................................. 26
Figure 18 – Edit Group Description Dialog Box ..................................................... 27
Figure 19 – Design Area Example 2 ....................................................................... 29
Figure 20 – Graded Width Examples for Perforated Tube Supports ....................... 31
Figure 21 – Perforated Tube Example #1 Cross Section ....................................... 34
Figure 22 – Perforated Tube Example #1 Data Input Screen .................................. 36
Figure 23 – Perforated Tube Example #2 Cross Section ....................................... 37
Figure 24 – Perforated Tube Example #2 Data Input Screen ................................ 39
# Table of Figures

- Figure 25 – Perforated Tube Example #3 Cross Section .................................................. 40
- Figure 26 – Perforated Tube Example #3 Data Input Screen ........................................... 42
- Figure 27 – Perforated Tube Project Book ..................................................................... 43
- Figure 28 – Perforated Tube Project Book Margins Setup .............................................. 45
- Figure 29 – Perforated Tube Project Book Page Setup .................................................... 45
- Figure 30 – Perforated Tube Project Book Columns Setup ........................................... 45
- Figure 31 – Export RTF "Output To" Window ................................................................ 47
- Figure 32 – Import/Export Projects Dialog Box ............................................................. 50
- Figure 33 – Pavement Depth Methods .......................................................................... 53
- Figure 34 – Cur b and Gutter Section ............................................................................ 54
- Figure 35 – Inslope only ............................................................................................... 54
- Figure 36 – Inslope with Secondary Slope ..................................................................... 54
- Figure 37 – Inslope with Secondary Slope and Upward Back Slope ............................... 54
- Figure 38 – Inslope with Secondary Slope and Downward Back Slope ......................... 54
- Figure 39 – Inslope with Secondary Slope, Downward Back Slope, and Upward Original Ground ................................................................. 55
- Figure 40 – Inslope with Secondary Slope, Downward Back Slope, and Downward Original Ground ................................................................. 55
- Figure 41 – Inslope with Ditch Bottom ......................................................................... 55
- Figure 42 – Inslope with Ditch Bottom and Upward Back Slope ................................... 55
- Figure 43 – Inslope with Ditch Bottom and Downward Back Slope ............................... 55
- Figure 44 – Inslope with Ditch Bottom, Upward Back Slope, and Upward Original Ground ......................................................................................... 56
- Figure 45 – Inslope with Ditch Bottom, Upward Back Slope, and Downward Original Ground ......................................................................................... 56
- Figure 46 – Inslope with Upward Back Slope ................................................................ 56
<table>
<thead>
<tr>
<th>Figure</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Figure 47</td>
<td>Inslope with Upward Back Slope and Upward Original Ground</td>
<td>56</td>
</tr>
<tr>
<td>Figure 48</td>
<td>Inslope with Upward Back Slope and Downward Original Ground</td>
<td>56</td>
</tr>
<tr>
<td>Figure 49</td>
<td>Standards Maintenance Password Window</td>
<td>58</td>
</tr>
<tr>
<td>Figure 50</td>
<td>Standards Maintenance Window</td>
<td>58</td>
</tr>
<tr>
<td>Figure 51</td>
<td>Pipe Standards Maintenance Dialog Box</td>
<td>60</td>
</tr>
<tr>
<td>Figure 52</td>
<td>W-Shape Standards Maintenance Dialog Box</td>
<td>61</td>
</tr>
<tr>
<td>Figure 53</td>
<td>Standard Assembly Maintenance Dialog Box</td>
<td>62</td>
</tr>
<tr>
<td>Figure 54</td>
<td>Perforated Tube Maintenance Dialog Box</td>
<td>65</td>
</tr>
<tr>
<td>Figure 55</td>
<td>Perforated Tube Sequence Dialog Box</td>
<td>68</td>
</tr>
<tr>
<td>Figure 56</td>
<td>Variable Sign Width Dialog Box</td>
<td>69</td>
</tr>
<tr>
<td>Figure 57</td>
<td>Variable Sign Height Dialog Box</td>
<td>71</td>
</tr>
<tr>
<td>Figure 58</td>
<td>Import/Export Standards Dialog Box</td>
<td>72</td>
</tr>
</tbody>
</table>
Introduction

The Sign Calculator is a Microsoft Access 2007 database that is used to determine the size and lengths of posts for roadside signs. The support size and length are calculated based on a cross section of the roadway that is inputted into the database.

There are two areas where the sign supports are calculated: one area is for pipe/w-shape supports and one area is for perforated tube supports. Both areas have the same basic input fields.

The following is the basic data needed to design a sign support for a sign:

1. What is being done with the sign (i.e. new, reset, etc.)
2. The type of sign support you want to design
3. Cross section at the sign location
4. Size of sign(s)

The data is entered in a user friendly environment and then with a simple press of a button, the results are tabulated in a plan sheet that is ready to be printed and inserted into the plans.

Each area of the Sign Calculator is broken up into projects and within each project there are records. Each record is an entry in the project that contains information about the sign being worked on.

There is not a limit on how many projects can be added to the database, but it is a good idea to periodically remove the projects that have been finalized.
Installation

System Requirements

- Microsoft Access 2007 or Microsoft Office 2007 Professional Edition
- Microsoft Windows 2000 operating system or higher
- Minimum screen resolution of 1280 x 1024 (for best view ability)

Local Installation

1. Create a folder under the C:\Program Files folder named ds_signs.
2. Copy the Signs.mde and Secured.mdw files into this folder.
3. Right-click on Signs.mde and select “Properties.” Make sure that the “Read Only” attribute is not checked and click “OK.”
4. Right-click on the Signs.mde file and drag it to your Desktop and select “Create shortcut(s) here.”
5. Right-click and choose “Properties” from the context menu.
6. Type the following text in the “Target” field:

   "C:\Program Files\Microsoft Office\Office12\MSACCESS.EXE" "C:\Program Files\ds_signs\Signs.mde" /WRKGRP "C:\Program Files\ds_signs\Secured.mdw"

   If Microsoft Access is installed in a different location than the one shown in the statement above, make sure to change the path appropriately. If a newer version than Microsoft Office 2007 is installed, change the version number to the correct number in the statement shown above.
7. Right-click and choose “Rename” from the context menu and change the shortcut name to “Signs.”

Server Installation

1. Create a folder on your server called ds_signs.
2. Make your users have “Modify” permissions to this folder.
3. Copy the Signs.mde and Secured.mdw files into the ds_signs folder.

4. Right-click on Signs.mde and select “Properties.” Make sure that the “Read Only” attribute is not checked and click “OK.”

5. Right-click and drag the Signs.mde file to your user’s Desktop and select “Create shortcut(s) here.”

6. Right-click and choose “Properties” from the context menu.

7. Type the following text in the “Target” field:

   "C:\Program Files\Microsoft Office\Office12\MSACCESS.EXE" "Server Path\ds_signs\Signs.mde" /WRKGRP " Server Path\ds_signs\Secured.mdw"

Substitute the path of the location of the ds_signs folder where Server Path is shown in the above statement.

If Microsoft Access is installed in a different location than the one shown in the statement above, make sure to change the path appropriately. If a newer version than Microsoft Office 2007 is installed, change the version number to the correct number in the statement shown above.

8. Right-click and choose “Rename” from the context menu and change the shortcut name to “Signs.”
Launching the Database

Getting Started

1. Locate the icon called “Signs” on your desktop (if you cannot find the icon on your desktop, contact the installer and ask them where they installed it.)

2. Double-click the icon.

3. Microsoft Access should launch and you should get a Logon dialog box (if Access does not launch or you get an error, contact your installer.)

4. Type “user” in the name field if it is not already there.

5. In the password field, type “signs” and click OK.

6. You should get the Startup screen shown below.

Startup Screen

From the Startup screen you are able to choose the type of support you want to design or you can upload/download tables to the database.

Figure 1 – Sign Calculator Startup Screen

1. **Version Fields**: Displays the date of latest version of the database. These dates can be used to ensure that you have the most up to date tables for the database.
2. **Pipe/W-Shape Button**: Button that launches the Pipe/W-Shape support calculator. From here you can design pipe and w-shape supports and print sign summary sheets for your plans.

3. **Perforated Tube Button**: Button that launches the Perforated Tube support calculator. From here you can design perforated tube supports and print sign summary sheets for your plans.

4. **Exit Signs Program**: Button used to exit the Sign Calculator database.

5. **Import/Export Projects Button**: Button that allows the user to upload/download project tables into the database. From here you are able to download data from your existing projects so that it can be imported into a newer version of the database. See the Support section on page 52 for the web address for updates.

6. **Standards Maintenance**: Button that launches the area used to update the standard assemblies, add support sizes, and add variable length signs. This area is password protected and can only be updated by an authorized person in the ND Department of Transportation, Design Division, Traffic Safety Section. When this area is updated, it will be made available so that it can be uploaded into your existing database.
Pipe/W-Shape Calculator

Data Input Screen

Start the Pipe/W-Shape Calculator by clicking on the **Pipe/W-Shape** button on the Startup screen (see Startup Screen section). The data input screen shown below should open up.

![Pipe/W-Shape Calculator Data Input Screen](image)

Figure 2 – Pipe/W-Shape Calculator Data Input Screen

1. **Project #**: Project number as it will appear on the plan sheet in the Project Number block.

2. **Revision**: Date of plan revision, if there is one. When you have a plan revision to the sign summary, enter the date here and it will be printed on your plan sheet.

3. **Description**: Plan sheet title block description as it will appear on the plan sheet. To add additional lines to the description, hold down **Ctrl** and press **Enter**.

4. **Designer**: Name of the person entering the data into the sign calculator database.

5. **Engineer**: Name of the PE that is sealing the plan sheet.

6. **Seal #**: Registration Number of the PE that is sealing the plan sheet. When typing in the number, type “PE-” in front of the number (i.e. PE-9999.)
7. **Date**: Date that you created the sign calculator project.

8. **Include Seal?**: Place a check in this box when you want to include the electronic distribution statement on the plan sheet.

9. **Seal Date**: Date that the PE sealed the plan sheet.

10. **Find Project**: Choose the active project to display from the drop down menu. The projects are listed in the order they were created.

11. **Sort Stations**: Choose the way you want the data sorted on the plan sheet. You can choose between ascending (0-9) and descending (9-0.) The data is sorted by group and then by Sta/RP.

12. **Calculate Toggle**: Choose whether you want to calculate the sign you are working on or all the signs within the active project.

   **Hint**: By calculating the sign you are working on each time, you are able to fix any errors as they occur. If you calculate the entire project and you have an error, the error can be difficult to locate.

13. **Calculate**: Button used to run the calculations to determine the support size and length.

14. **Add Project**: Button used to add a new project to the database. The new project will appear at the bottom of the list in the Find Project drop down menu.

15. **Delete Project**: Button used to remove the active project from the database. If you want to delete a project other than the one you are in, you must first choose it from the Find Project drop down menu.

16. **Project Book**: Button used to generate the plan sheet for the active project. (See the Project Book section on page 20 for more information.) You will be asked to enter a starting page number to be printed on the plan sheet. If you leave the field blank or press **Cancel**, a “1” will be used as the starting page number.

17. **Export to RTF**: Button used to export the active project’s plan sheet output into an RTF (Rich Text Format) file. Once the file has been exported it can be brought into Microsoft Word and then copied and pasted into MicroStation. (See the Exporting RTF Files section on page 47 for more information.)

18. **Input Sheet**: Button used to display a spreadsheet style format of your input data. This screen can be useful when you are trying to track down an error. It also can be used to look at data from multiple signs simultaneously (see Figure 3.)
Pipe/W-Shape Calculator

Data Input Screen

Figure 3 – Pipe/W-Shape Input Sheet

19. **Notes Report**: Button used to display all the notes/warnings for the active project. This can be a useful tool for quickly finding and fixing warnings and errors (see Figure 4.)

![Pipe/W-Shape Notes Report](image)

Figure 4 – Pipe/W-Shape Notes Report

20. **Edit Group Description**: Button used to edit the existing groups within the active project. After the Groups have been added into the project using the **Group No** field, you can change the description using this screen (see Figure 5.)
Figure 5 – Edit Group Description Dialog Box

21. **Close Form**: Button used to close the Pipe/W-Shape Data Input Screen.

22. **Sta/RP**: Station or RP of the sign you are working on. Enter in the location of the sign as a Station or Reference Point. (i.e. 198+12 or 45.753)

   **Hint**: If you are having problems getting your Sta/RP to sort in the correct order, try putting a space as a place holder in front of the smaller numbers. (i.e. 456+45, 85+12, 1+86)

23. **Sta Dir**: Position of the sign relative to the Station/RP direction. Choose Rt, Rt mdn, Lt mdn, or Lt from the drop down menu.

24. **NAS**: Sign number or special assembly number of the sign. Enter in the sign number or the special assembly number from the sign details. (i.e. SN 45 or S.A.A)

25. **Group No**: Number of the group that the sign is in. A group number is not needed, but it can be used to create subtotals or to break signs into separate groups. (i.e. Group 1 – I-94 Mainline, Group 2 – 45th Street, etc.)

   **Hint**: If you are working on a roadway that has an equation and the stationing is smaller ahead than it is back, a group could be used to separate the two segments. This would make sure the signs stay in the correct order in the Project Book. (i.e. 954+54 Bk = 0+00 Ahd)

26. **Duplicate Sign**: Button used to create a copy of the active sign record. If you have a sign that is similar to a sign that you have already inputted, you do not need to retype the information. You can use the **Duplicate Sign** feature to copy the active sign record into a new record. You will be prompted to enter a new Station/RP for the new sign.
27. **Find Station**: Drop down menu used to find a sign in the active project. To quickly find a sign in the active project, choose a location from the drop down menu. The signs are listed in the order they were entered into the database.

28. **Sign Type**: Choose the type of sign you want to design (see Figure 6.)

29. **Sign Width**: Enter in the total width of the sign(s) in inches.  
   
   **Note:** Do not include perpendicular signs, auxiliary signs, or EXIT sign panels.

30. **Sign Height**: Enter in the total height of the sign(s) in inches.  
   
   **Note:** Do not include perpendicular signs, auxiliary signs, or EXIT # sign panel.

31. **Exit Sign Height**: Enter in the height of the EXIT # sign panel.

32. **Perp Sign Height**: Enter in the height of the perpendicular sign (i.e. One Way signs on top of a Do Not Enter sign) in inches.

33. **Aux Width**: Enter in the width of the auxiliary sign in inches.

34. **Aux Height**: Enter in the height of the auxiliary sign in inches.

35. **Sign to Top Post**: Enter in the distance from the top of the post to the top of the sign(s) in inches. This distance includes the perpendicular sign.
36. **# of Reset Signs**: Enter a 1 if there are signs to be reset at this location.

**Note**: Remember, the quantity “Reset Sign Panels” is paid for per location and not per sign.

37. **Design Area**: The largest total surface area of the signs viewed from any given side. In Figure 7, the design area would be 16.0 ft$^2$ not 19.0 ft$^2$. The design area is measured in square feet and by default is calculated automatically from the **Sign Height** and **Sign Width** fields. If the design area is different than what is calculated, enter in the correct value.

![Design Area Example](image)

38. **Pay Area**: The total square footage of sign face area for each type of sign material. For a complete list of when to use each type of sign material, consult the Permanent Signing section in the North Dakota Department of Transportation’s Design Manual.

39. **Location**: Choose the type of installation from the following choices:

   A. **Ditch/Shoulder**: For use on offset signs (60’ to center of sign from the edge of driving lane) or signs installed on the inslope just off the shoulder.

   B. **Gore**: Used on signs installed in the gore area of an exit ramp.

   C. **Curb**: Used when a sign is installed behind the curb.
D. **Overhead**: Used when a sign is installed overhead or on an overhead sign structure support (i.e. bridge clearance sign mounted on a bridge or an exit ramp advisory speed sign mounted on a cantilever overhead sign support.)

40. **Support Info**: Choose the type of support the sign will be mounted on.

   A. **New**: Used when the sign is installed on a new support.

   B. **Reset**: Used when the sign is installed on a reset support.

   C. **Overhead**: Used when a sign is installed overhead or on an overhead sign structure support (i.e. bridge clearance sign mounted on a bridge or an exit ramp advisory speed sign mounted on a cantilever overhead sign support.)

   D. **Existing**: Used when the sign is installed on an existing support.

41. **Pavement Depth**: Thickness of pavement in inches. To accommodate future overlays, 3” should be added to the pavement depth in locations where an overlay may be possible. There are three basic methods used to determine the pavement depth:

   A. **Actual Pavement Depth**: The actual pavement thickness is used as the pavement depth (plus 3” buffer.)

   B. **Arbitrary Pavement Depth**: The pavement depth is chosen to be something that makes it easier to input the cross section data. For example, if the inslope starts at the bottom of the base, the pavement depth could be the pavement thickness plus the base thickness. It could also be the overlay thickness on a resurfacing project. The 3” buffer is also added when using this method.

   C. **Zero Pavement Depth**: A pavement thickness of zero plus the 3” buffer is used as the pavement depth. This method could be used when the inslope starts at the edge of the concrete pavement.

42. **Vertical Clearance**: Vertical distance, in inches, from the bottom of sign(s) to the highest point in the driving lane(s). The highest point is generally at the center of the roadway. See ND Standard Drawing D-754-1 for the minimum vertical clearances.

43. **Graded Width**: The graded width is double the distance, in inches, from the highest point in the driving lane(s) to the point where the bottom of the pavement depth intersects the inslope (Point A in Figure 8.) The program assumes that the roadway is symmetrical and if it is not, it has to be adjusted as shown in the examples below. For Sign 2, the graded width is calculated as 24’ x 2 = 48’ or 576”.

---

Sign Calculator Manual.docx
44. **Graded Shldr to Sign**: The distance, in inches, from the edge of the graded width to the edge of the sign(s) closest to the roadway. For example, the graded shoulder to sign distance for Sign 1, in Figure 8, can be calculated as 18’ (the minimum required horizontal distance, see ND Standard Drawing D-754-1) minus 4’ (shoulder width) minus 4’ (distance from the shoulder to Point A.) Therefore, the graded shoulder to sign distance for Sign 1 is 10’ or 120”.

45. **InPlace Post Type**: Choose the type of support to be reset from the drop down menu.

46. **InPlace Dia**: Choose the size of the support to be reset from the drop down menu.

47. **InPlace Length**: Enter in the length of the support to be reset in inches.

48. **# of Reset Posts**: Enter in the number of supports to be reset.

49. **Post Space**: Enter in the spacing, in inches, between the supports.

50. **Over Hang**: Enter in the over hang, in inches, from the support to the edge of the sign.

51. **Joint Revised**: Enter in the number of fuse joints revised.

52. **Stub Post**: When resetting pipe supports, a stub post must be used. The number of stub posts should be the same as the number of supports that are reset.

53. **Use Multi-Directional Break Away Bases**: Place a check mark in this box when the sign is on one support and it can be hit from more than one direction of traffic.
54. **Slopes**: Place a check mark in the box by the type of slope that pertains to the ditch section you are working on. For each type of slope that is checked, fill in the horizontal distance that it covers in inches. In the Rate field, type in the number that represents how many horizontal units there are for one vertical unit. See Appendix A – Typical Ditch Sections on page 53 for different combinations of the slopes.

A. **Inslope**: The slope that is adjacent to the roadway. The inslope runs down and away from the roadway.

B. **Secondary Slope**: The slope that is adjacent to the inslope. The secondary slope runs down and away from the inslope.

C. **Bottom of Ditch**: The area that is flat in the ditch section, usually between the inslope or secondary slope and the back slope.

D. **Back Slope**: The slope that usually follows the ditch bottom. The back slope can run either up and away or down and away. Choose either **Up** or **Down** in the Slope drop down menu for the direction the slope runs.

E. **Original Ground**: The area that usually follows the back slope. The original ground can run either up and away or down and away. Choose either **Up** or **Down** in the Slope drop down menu for the direction the slope runs.

55. **Fdn/Footing Info**: Choose the type of foundation or footing the sign support will be mounted on.

A. **New**: Used when the sign support is installed on a new foundation or footing.

B. **Existing**: Used when the sign support is installed on an existing foundation or footing.

C. **Remove Only**: Used when there is not a new sign at the location and you need to remove a foundation (s) or some footings.

56. **Soil Pressure**: Choose the soil pressure to be used to calculate the sign supports. Choose 500 if the soil pressure is not known.

57. **Removals**: Enter in the number of concrete foundations or H-pile footings to be removed.

58. **Support Type**: The output from the program showing the type of support the sign is mounted on.

59. **Pipe Length**: The output from the program showing the length of the pipe supports.
60. **Pipe Dia**: The output from the program showing the nominal diameter of the pipe supports or the size of the W-shape supports.

61. **Foundation Info**: The output from the program showing the diameter, depth, and volume of the concrete foundation if the sign is mounted on pipe supports.

62. **W-Shape Length**: The output from the program showing the length of the W-shape supports.

63. **W-Shape Footing Info**: The output from the program showing the total length of the H-pile footings.

64. **Max Post Len**: The output from the program showing the maximum length the signs supports can be. If a longer post is needed when the sign is installed, a cross section should be taken and the new data should be entered into the database to get the correct size of supports.

65. **Calculated Post Spacing**: The output from the program showing the post spacing used to calculate the sign supports.

66. **Reset Info**: The output from the program that will be shown on the Project Book under the Comments column.

   **Hint**: Any additional information that you want to appear with the sign in the Project Book can be entered here. **WARNING**: This information will be cleared if the sign is calculated again, so when calculating future signs, make sure you choose calculate by Current Sign and not by Project.

67. **Notes**: The output from the program showing any warnings or errors that you may have in your input data for the current sign. This information is shown in the Notes Report when you click on the Notes Report button.

68. **Record Number**: The record number is used by the program to keep track of individual signs. Each sign entry is given a record number. If you want to delete a record or sign entry, select tall vertical bar on the left side of the entry form and press the Delete button in the Records section of the Home tab.

69. **Clearance Options**: Place a check mark next to the types of vertical clearances used for the project. To add a custom vertical clearance, type the description in the text box and place a check mark in the box next to the description. This information will be printed on the bottom of the Project Book sheets.
**Example**

In this section we will be going through the steps of creating a project and a new sign record in the database. We will be installing a new main sign and resetting & overlaying the EXIT panel sign on new supports. The existing sign was mounted on pipe supports, so we will have to remove the existing foundations. The new sign is 15’-6” x 4’-0” and the existing EXIT panel is 9’-0” x 2’-6”.

![Figure 9 – Pipe/W-Shape Example Cross Section](image)

1. Launch the Sign Calculator (see Launching the Database on page 4.)
2. Click the **Pipe/W-Shape** button on the Startup Screen.
3. Click the **Add Project** button.
4. In the **Project #** field, type in “IM-8-094(999)323.”
5. Type the following text in the **Description** field:
   - A. Ctrl + Enter
   - B. “I-94 Westbound Roadway”
   - C. Ctrl + Enter
   - D. Ctrl + Enter
   - E. Ctrl + Enter
   - F. “One Mile West of Wheatland to Casselton”
6. Type today’s date in the **Date** field.
7. Type your name into the **Designer** field.
8. In the **Sta/RP** field, type in “323.163.”
9. In the **Sta Dir** drop down menu, choose “Lt.”

10. Type “SN 1” in the **NAS** field.

11. Choose “Exit Number with Main Sign” in the **Sign Type** box.

12. Type the sign width, “186”, and the sign height, “48”, in the appropriate fields.

13. In the **Design Area** field, type in the total sign area, “84.5.” Notice how the field already had a default value of 62. This was calculated automatically by using the sign width and height that you entered in above.

14. In the **Exit Sign Height** field, type in “30.”

15. Since we are resetting the existing EXIT panel, we need to enter a “1” in the **# of Reset Signs** field.

16. In the **Sign Material** box, put a check by “Hi Int (3A) Panel” and “Hi Int (3A) Overlay Panel.” The Hi Int (3A) Panel is for the main sign and the Hi Int (3A) Overlay Panel is for the EXIT panel sign.

17. Type in “62” in the **Pay Area** field for the Hi Int (3A) Panel and “22.5” in the **Pay Area** field for the Hi Int (3A) Overlay Panel.

18. In the **Location** box, select “Ditch/Shoulder.”

19. Select “New” in the **Support Info** box.

20. Now we will enter the information about the cross section of the roadway and the ditch. There are two ways to do this:

   A. Use the **Actual Pavement Depth** method:

      1. Enter a “15” in the **Pavement Depth** field (12” of pavement + 3” buffer.)

      2. Type “60” in the **Vertical Clearance** field.

      3. The **Graded Width** is the graded width as explained in the Data Input Screen section on page 12.

         \[12’ (driving lane) + 10’ (shoulder) + 4’ (shoulder to Point A)] \times 2 = 52’ = 624”

         Enter “624” in the **Graded Width** field.

      4. The **Graded Shldr to Sign** is therefore the distance from Point A to the edge of the sign.
Pipe/W-Shape Calculator

Example

\[60' – 10'(shoulder) – 4'(shoulder to Point A) – 15.5'/2 (1/2 sign width) = 38.25' = 459''\]

Enter “459” in the **Graded Shldr to Sign** field.

5. Using this method, the **Inslope** starts at Point A. Place a check in the **Inslope** box and enter “144” in the **Distance** field and “4” in the **Rate** field.

6. Place a check in the **Secondary Slope** box and enter “144” in the **Distance** field and “24” in the **Rate** field.

7. Place a check in the **Ditch Bottom** box and enter “144” in the **Distance** field.

8. Place a check in the **Back Slope** box and enter “192” in the **Distance** field, “4” in the **Rate** field, and choose “Up” in the **Slope** drop down menu.

9. Place a check in the **Original Ground** box and enter “54” in the **Distance** field, “12” in the **Rate** field, and choose “Up” in the **Slope** drop down menu.

B. **Use the Zero Pavement Depth method:**

1. Enter a “3” in the **Pavement Depth** field (0” + 3” buffer.)

2. Type “60” in the **Vertical Clearance** field.

3. The **Graded Width** is the top of the pavement.

\[[12' (driving lane) + 10' (shoulder)] x 2 = 44’ = 528’\]

Enter “528” in the **Graded Width** field.

4. The **Graded Shldr to Sign** is therefore the distance from the paved shoulder to the edge of the sign.

\[60’ – 10’ (shoulder) – 15.5'/2 (1/2 sign width)] = 42.25’\]

Enter “507” in the **Graded Shldr to Sign** field.

5. Using this method, the **Inslope** starts at the edge of the shoulder. Place a check in the **Inslope** box and enter “192” in the **Distance** field and “4” in the **Rate** field.

6. Place a check in the **Secondary Slope** box and enter “144” in the **Distance** field and “24” in the **Rate** field.
7. Place a check in the **Ditch Bottom** box and enter “144” in the **Distance** field.

8. Place a check in the **Back Slope** box and enter “192” in the **Distance** field, “4” in the **Rate** field, and choose “Up” in the **Slope** drop down menu.

9. Place a check in the **Original Ground** box and enter “54” in the **Distance** field, “12” in the **Rate** field, and choose “Up” in the **Slope** drop down menu.

21. Choose “New” in the **Fdn/Footing Info** box.

22. The soil pressure is not known so choose a **Soil Pressure** of “500 psi.”

23. Enter a “2” in the **Removals** box for **# of Fdns**.

24. Choose “Current Sign” in the **Calculate** box and click the **Calculate** button. The screen should look similar to the shown in Figure 10.

---

**Figure 10 – Pipe/W Shape Example Data Input Screen**
**Project Book**

The Project Book is the tabulated results of the calculations from your input data in a user friendly format that can be viewed on the screen or printed as plan sheets. You can launch the Project Book by clicking the **Project Book** button from the Data Input screen. The screen should look similar to the one shown in Figure 11.

![Figure 11 – Pipe/W Shape Project Book](image)

**Parts of the Project Book**

1. The Project Number is displayed as it was typed into the **Project #** field on the Data Input screen.

2. The signs are listed by their Station/Reference Point. Choose from ascending or descending order in the **Sort Stations** box on the Data Input screen.

3. The Sign/Assembly Number is displayed as it was typed into the **NAS** field on the Data Input screen.

4. The quantity of sign material is shown in this column.

5. The length of pipe calculated by the program is displayed here.

6. The calculated size of the pipe or w-shape is displayed here.
7. The length of w-shape calculated by the program is displayed here.

8. The maximum post length for both the pipe and w-shape supports is shown here.

9. The spacing between the supports is shown here.

10. The quantity of revised fuse joints is displayed in this column.

11. The size of the concrete foundations is shown here.

12. The quantity of H-pile footings is displayed in this column.

13. The quantity of concrete foundations to be removed is shown here.

14. The quantity of H-pile footings to be removed is shown here.

15. The number of locations where signs are to be reset is shown here.

16. The number of sign supports to be reset is shown here.

17. The number of stub posts to be installed is shown here.

18. The number of multi-directional break away bases to be installed is shown here.

19. Comments are displayed as shown in the **Reset Info** field on the Data Input screen.

20. The signs are broken up into subtotals by using different **Group Numbers**, on the Data Input screen, to group them together.

21. The totals of all the quantities for an entire project are shown in the Grand Total line.

   **Hint:** To get the total quantity of “Galv Steel Posts-W-Shape Posts(Two Or More)”, add the grand totals of column 7 and column 12.

22. The plan sheet title block is displayed as shown in the **Description** field on the Data Input screen.

23. The PE seal block displays the electronic distribution statement when that option is selected (see **Include Seal?** on page 7.)

**Printing the Project Book**

Before you print the project book, you have to setup the page layout to ensure that it prints correctly and can be used as a plan sheet.
1. From inside the Project Book screen, open the **Page Setup** dialog box.

2. Select the **Margins** tab and set the margins as shown in Figure 12.

   ![Figure 12 – Pipe/W-Shape Project Book Margins Setup](image)

3. Select the **Page** tab and set the page settings as shown in Figure 13. The 11 x 17 paper size option may not be available on your printer (it may be called Tabloid or something else.) Choose the paper size that represents an 11 x 17 paper size.

   ![Figure 13 – Pipe/W-Shape Project Book Page Setup](image)

4. Select the **Columns** tab and set the column settings as shown in Figure 14.

   ![Figure 14 – Pipe/W-Shape Project Book Columns Setup](image)
5. Click the **OK** button to close and accept the page setup.

6. Click on the **Print** button.

7. Choose the printer you want to send the project book to and click **OK**.
Perforated Tube Calculator

Data Input Screen

Start the Perforated Tube Calculator by clicking on the Perforated Tube button on the Startup screen (see Startup Screen section on page 4.) The data input screen shown below should open up.

Figure 15 – Perforated Tube Calculator Data Input Screen

1. **Project #**: Project number as it will appear on the plan sheet in the Project Number block.

2. **Revision**: Date of plan revision, if there is one. When you have a plan revision to the sign summary, enter the date here and it will be printed on your plan sheet.

3. **Description**: Plan sheet title block description as it will appear on the plan sheet. To add additional lines to the description, hold down Ctrl and press Enter.

4. **Designer**: Name of the person entering the data into the sign calculator database.

5. **Engineer**: Name of the PE that is sealing the plan sheet.

6. **Seal #**: Registration Number of the PE that is sealing the plan sheet. When typing in the number, type “PE-” in front of the number (i.e. PE-9999.)

7. **Date**: Date that you created the sign calculator project.
8. **Include Seal?**: Place a check in this box when you want to include the electronic distribution statement on the plan sheet.

9. **Seal Date**: Date that the PE sealed the plan sheet.

10. **Find Project**: Choose the active project to display from the drop down menu. The projects are listed in the order they were created.

11. **Sort Stations**: Choose the way you want the data sorted on the plan sheet. You can choose between ascending (0-9) and descending (9-0). The data is sorted by group and then by Sta/RP.

12. **Calculate Toggle**: Choose whether you want to calculate the sign you are working on or all the signs within the active project.

   **Hint**: By calculating the sign you are working on each time, you are able to fix any errors as they occur. If you calculate the entire project and you have an error, the error can be difficult to locate.

13. **Calculate**: Button used to run the calculations to determine the support size and length.

14. **Add Project**: Button used to add a new project to the database. The new project will appear at the bottom of the list in the Find Project drop down menu.

15. **Delete Project**: Button used to remove the active project from the database. If you want to delete a project other than the one you are in, you must first choose it from the Find Project drop down menu.

16. **Project Book**: Button used to generate the plan sheet for the active project. (See the Project Book section on page 43 for more information.) You will be asked to enter a starting page number to be printed on the plan sheet. If you leave the field blank or press **Cancel**, a “1” will be used as the starting page number.

17. **Export to RTF**: Button used to export the active project’s plan sheet output into an RTF (Rich Text Format) file. Once the file has been exported it can be brought into Microsoft Word and then copied and pasted into MicroStation. (See the Exporting RTF Files section on page 47 for more information.)

18. **Input Sheet**: Button used to display a spreadsheet style format of your input data. This screen can be useful when you are trying to track down an error. It also can be used to look at data from multiple signs simultaneously (see Figure 16.)
19. **Notes Report**: Button used to display all the notes/warnings for the active project. This can be a useful tool for quickly finding and fixing warnings and errors (see Figure 17.)

![Perforated Tube Notes Report](image)

**Figure 17 – Perforated Tube Notes Report**

20. **Edit Group Description**: Button used to edit the existing groups within the active project. After the Groups have been added into the project using the **Group No** field, you can change the description using this screen (see Figure 18.)
### Figure 18 – Edit Group Description Dialog Box

21. **Close Form**: Button used to close the Pipe/W-Shape Data Input Screen.

22. **Sta/RP**: Station or RP of the sign you are working on. Enter in the location of the sign as a Station or Reference Point. (i.e. 198+12 or 45.753)

   **Hint**: If you are having problems getting your Sta/RP to sort in the correct order, try putting a space as a place holder in front of the smaller numbers. (i.e. 456+45, 85+12, 1+86)

   **Warning**: The **Sta/RP** field is a required field and cannot be left blank.

   **Hint**: You cannot have the same **Sta/RP** unless you have a different **Sta Dir**. But sometimes you may need to have the same **Sta/RP** and **Sta Dir**. For example, let’s say you have a roadway with several equations and they all start over with Sta 0+00. Let’s also say that there is a sign at Sta 1+02 rt in two of the segments. In order to enter both of these signs into the database, something will have to be different. You could either move one of the signs a foot or place a decimal at the end of one of the stations. (i.e. 1+02 rt and 1+02. rt)

23. **Sta Dir**: Position of the sign relative to the Station/RP direction. Choose Rt, Rt mdn, Lt mdn, or Lt from the drop down menu.

   **Warning**: The **Sta Dir** field is a required field and cannot be left blank.

24. **Sign No**: Sign number or special assembly number of the sign. Enter in the sign number or the special assembly number from the sign details. (i.e. SN 45 or S.A.A)

25. **Group No**: Number of the group that the sign is in. A group number is not needed, but it can be used to create subtotals or to break signs into separate groups. (i.e. Group 1 – Mapleton Intchg Crossroad, Group 2 – Raymond Intchg Crossroad, etc.)
**Hint:** If you are working on a roadway that has an equation and the stationing is smaller ahead than it is back, a group could be used to separate the two segments. This would make sure the signs stay in the correct order in the Project Book. (i.e. 954+54 Bk = 0+00 Ahd)

26. **Duplicate Sign:** Button used to create a copy of the active sign record. If you have a sign that is similar to a sign that you have already inputted, you do not need to retype the information. You can use the **Duplicate Sign** feature to copy the active sign record into a new record. You will be prompted to enter a new Station/RP for the new sign.

27. **Find Station:** Drop down menu used to find a sign in the active project. To quickly find a sign in the active project, choose a location from the drop down menu. The signs are listed in the order they were entered into the database.

28. **Sign Type:** Choose the type of sign you want to design:

   A. **Standard Assembly:** Choose this type if the sign(s) is one of the standard assemblies shown on ND Standard Drawings D-754-26–45 & 51–75.

   B. **Variable Length Sign:** Choose this type if the sign is one of the sizes shown on ND Standard Drawing D-754-47–50.

   C. **Non Standard Sign:** Choose this type if the sign is not one of the other two types. This is the type used for special assemblies.

29. **Assembly Number:** Enter in the assembly number of the sign(s) as shown in the ND Standard Drawings D-754-26–45 & 51–75. If it is either a **Variable Length Sign** or a **Non Standard Sign**, this field will be blank.

30. **Sign Width:** Enter in the total width of the sign(s) in inches. For **Standard Assembly** signs, this field will automatically be filled in.

31. **Sign Height:** Enter in the total height of the sign(s) in inches. For **Standard Assembly** signs, this field will automatically be filled in.

   **Warning:** Do not include any perpendicular signs that are above the main signs. By including them, you will inadvertently change where the moment is calculated for wind load.

32. **Design Area:** The largest total surface area of the signs viewed from any given side. In Figure 19, the design area would be 7.81 ft² not 10.44 ft². For the **Non Standard Signs**, the design area is calculated automatically from the **Sign Height** and **Sign Width** fields. If the design area is different than what is calculated, enter in the correct value. The design area is automatically filled in for the **Standard Assembly** and **Variable Length Signs**.
33. **Sign to Top Post**: Enter in the distance from the top of the post to the top of the sign(s) in inches.

   **Hint**: For perpendicular signs, enter in a minus number and this will add post length to the top of the sign. In Figure 19, you would enter a “-9” in the **Sign to Top Post** field.

34. **# of Reset Signs**: Enter a 1 if there are signs to be reset at this location. Remember, the quantity “Reset Sign Panels” is paid for per location and not per sign.

35. **Pay Area**: The total square footage of sign face area for each type of sign material. For a complete list of when to use each type of sign material, consult the Permanent Signing section in the North Dakota Department of Transportation’s Design Manual. For the **Standard Assembly** and **Variable Length Signs**, the pay area is automatically filled in. All you need to do is put a check by the type of material you want to use. For the Non Standard Signs, put a check by the type of material and enter the pay area in square feet.

36. **Location**: Choose the type of installation from the following choices:

   A. **Ditch/Shoulder**: For use on signs installed on the inslope just off the shoulder.

   B. **Curb**: Used when a sign is installed behind the curb.

   C. **Light Standard**: Used when a sign is mounted on the light standard pole.
D. **Mast Arm**: Used for street name signs or lane use control signs that are mounted on the mast arm of a traffic signal standard.

E. **Barricade**: Used when a sign is mounted on a barricade.

F. **Span Wire**: Used when a sign is mounted on the span wire of an interim traffic signal system.

G. **Signal**: Used when a sign is mounted on a traffic signal standard pole.

37. **Support Info**: Choose the type of support the sign will be mounted on.

   A. **New**: Used when the sign is installed on a new support.

   B. **Reset**: Used when the sign is installed on a reset support.

   C. **Existing**: Used when the sign is installed on an existing support.

38. **Pavement Depth**: Thickness of pavement in inches. To accommodate future overlays, 3” should be added to the pavement depth in locations where an overlay may be possible. There are three basic methods used to determine the pavement depth:

   A. **Actual Pavement Depth**: The actual pavement thickness is used as the pavement depth (plus 3” buffer.)

   B. **Arbitrary Pavement Depth**: The pavement depth is chosen to be something that makes it easier to input the cross section data. For example, if the inslope starts at the bottom of the base, the pavement depth could be the pavement thickness plus the base thickness. It could also be the overlay thickness on a resurfacing project. The 3” buffer is also added when using this method.

   C. **Zero Pavement Depth**: A pavement thickness of zero plus the 3” buffer is used as the pavement depth. This method could be used when the pavement slough matches the inslope rate.

39. **Vertical Clearance**: Vertical distance, in inches, from the bottom of sign(s) to the highest point in the driving lane(s). The highest point is generally at the center of the roadway. See ND Standard Drawing D-754-23 for the minimum vertical clearances.

40. **Graded Width**: The graded width is double the distance, in inches, from the highest point in the driving lane(s), which pertains to the sign, to the point where the bottom of the pavement depth intersects the inslope (Point A in Figure 20.) The program assumes that the roadway is symmetrical and if it is not, it has to be adjusted as shown in the examples below. For Sign 1, the graded width is calculated as 3’ x 2 = 6’ or 72”.
41. **Graded Shldr to Sign**: The distance, in inches, from the edge of the graded width to the edge of the sign(s) closest to the roadway. For example, the graded shoulder to sign distance for Sign 3, in Figure 20, can be calculated as 18’ (the minimum required horizontal distance, see ND Standard Drawing D-754-23) minus 4’ (shoulder width) minus 3’ (distance from the shoulder to Point A.) Therefore, the graded shoulder to sign distance for Sign 3 is 11’ or 132”.

42. **InPlace Size**: Choose the size of the support to be reset from the drop down menu.

43. **InPlace Length**: Enter in the length of the support to be reset in inches.

44. **# of Reset Posts**: Enter in the number of supports to be reset.

45. **Post Space**: Enter in the spacing, in inches, between the supports. For **Standard Assembly** and **Variable Length Signs**, this field will be filled in automatically.

46. **Over Hang**: Enter in the over hang, in inches, from the support to the edge of the sign. For **Standard Assembly** and **Variable Length Signs**, this field will be filled in automatically.

47. **Slopes**: Place a check mark in the box by the type of slope that pertains to the ditch section you are working on. For each type of slope that is checked, fill in the horizontal distance that it covers in inches. In the Rate field, type in the...
number that represents how many horizontal units there are for one vertical unit. See Appendix A – Typical Ditch Sections on page 53 for different combinations of the slopes.

A. **Inslope**: The slope that is adjacent to the roadway. The inslope runs down and away from the roadway.

B. **Secondary Slope**: The slope that is adjacent to the inslope. The secondary slope runs down and away from the inslope.

C. **Bottom of Ditch**: The area that is flat in the ditch section, usually between the inslope or secondary slope and the back slope.

D. **Back Slope**: The slope that usually follows the ditch bottom. The back slope can run either up and away or down and away. Choose either **Up** or **Down** in the Slope drop down menu for the direction the slope runs.

E. **Original Ground**: The area that usually follows the back slope. The original ground can run either up and away or down and away. Choose either **Up** or **Down** in the Slope drop down menu for the direction the slope runs.

48. **Pipe Size**: The output from the program showing the size of the perforated tube supports.

49. **Sleeve**: The output from the program showing the size of the sleeve to be used inside the perforated tube supports.

50. **Anchor Size**: The output from the program showing the size of the anchor to be used.

51. **Post Length**: The output from the program showing the lengths of the perforated tube supports.

52. **Sleeve Length**: The output from the program showing the lengths of the sleeves for the perforated tube supports.

53. **Anchor**: The output from the program showing how many anchors are needed.

54. **Anchor Length**: The output from the program showing the length of each anchor unit.

55. **Slip Base**: The output from the program showing how many slip bases are required.

56. **Max Post Len**: The output from the program showing the maximum length the signs supports can be. If a longer post is needed when the sign is installed, a cross
section should be taken and the new data should be entered into the database to get the correct size of supports.

57. **Calculated Post Spacing**: The output from the program showing the post spacing used to calculate the sign supports.

58. **Reset Info**: The output from the program that will be shown on the Project Book under the Comments column.

   **Hint**: Any additional information that you want to appear with the sign in the Project Book can be entered here. **WARNING**: This information will be cleared if the sign is calculated again, so when calculating future signs, make sure you choose calculate by Current Sign and not by Project.

59. **Notes**: The output from the program showing any warnings or errors that you may have in your input data for the current sign. This information is shown in the Notes Report when you click on the **Notes Report** button.

60. **Record Number**: The record number is used by the program to keep track of individual signs. Each sign entry is given a record number. If you want to delete a record or sign entry, select tall vertical bar on the left side of the entry form and press the **Delete** button in the **Records** section of the **Home** tab.

61. **Clearance Options**: Place a check mark next to the types of vertical clearances used for the project. To add a custom vertical clearance, type the description in the text box and place a check mark in the box next to the description. This information will be printed on the bottom of the **Project Book** sheets.
Examples

In this section we will be going through the steps of creating a project, finding a project, and adding new sign records to the database.

Example #1 – Two Lane Two-Way Roadway on a Curve

In this example, we will be installing a new speed limit sign (24’’ x 30’’) along the roadway. The roadway is a two lane two-way rural section on a curve. This project has two equations in the survey line, so the roadway should be broken up into three groups. The sign we are working on will be in the first segment of the survey line.

Figure 21 – Perforated Tube Example #1 Cross Section

1. Launch the Sign Calculator (see Launching the Database on page 4.)
2. Click the Perforated Tube button on the Startup Screen.
3. Click the Add Project button.
4. In the Project # field, type in “SS-5-021(999)052.”
5. Type the following text in the Description field:
   A. Ctrl + Enter
   B. Ctrl + Enter
   C. “ND Hwy 21”
   D. Ctrl + Enter
   E. Ctrl + Enter
   F. Ctrl + Enter
   G. Ctrl + Enter
   H. Ctrl + Enter
   I. “East Junction ND 8 East to West Junction ND 49”
6. Type today’s date in the **Date** field.

7. Type your name into the **Designer** field.

8. In the **Sta/RP** field, type in “699+77.”

9. In the **Sta Dir** drop down menu, choose “Rt.”

10. Type “1” in the **Group No** field and press Enter.

11. Click **Yes** to add the group to the list.

12. Type “ND Hwy 21” in the group description dialog box.

13. Choose “Standard Assembly” in the **Sign Type** box.

14. Enter a “9” in the **Assembly Number** field.

15. In the **Sign Material** box, put a check by “Hi Int (3A) Flat Sht” box.

16. In the **Location** box, select “Ditch/Shoulder.”

17. Select “New Post” in the **Support Info** box.

18. We will be using the **Actual Pavement Depth** method to determine the pavement thickness for this sign. Enter “8.5” in the **Pavement Depth** field (5.5” of pavement + 3” buffer.)

19. Type “60” in the **Vertical Clearance** field.

20. The **Graded Width** is taken from the highest point of the driving lane pertaining to the sign. Because this is a two lane two-way roadway, the right lane is the only lane that applies to the sign. Therefore, the highest point in the driving lane will be at the center of the roadway. (See the Data Input Screen section on page 30 for more information.)

\[
[12' \text{(driving lane)} + 5' \text{(shoulder)} + 2.5' \text{(shoulder to Point A)}] \times 2 = 39' = 468''
\]

Enter “468” in the **Graded Width** field.

21. The **Graded Shldr to Sign** is therefore the distance from Point A to the edge of the sign.

\[20' - 5' \text{(shoulder)} - 2.5' \text{(shoulder to Point A)} = 12.5' = 126''\]

Enter “126” in the **Graded Shldr to Sign** field.

22. The **Inslope** starts at Point A. Place a check in the **Inslope** box and enter “168” in the **Distance** field and “4” in the **Rate** field.
23. Choose “Current Sign” in the **Calculate** box and click the **Calculate** button. The screen should look similar to the shown in Figure 22.

**Figure 22 – Perforated Tube Example #1 Data Input Screen**
Example #2 – Two Lane Two-Way Roadway on a Tangent

In this example, a Distance & Destination sign (120” x 48”) will be reset on new supports along the roadway. The roadway is a two lane two-way rural section on a tangent. This sign will be added to the project started in Example #1 – Two Lane Two-Way Roadway on a Curve. This sign is in segment two of the survey line.

![Cross Section Diagram](image)

**Figure 23 – Perforated Tube Example #2 Cross Section**

1. Launch the Sign Calculator (see Launching the Database on page 4.) If you are still in the Perforated Tube Calculator, go to step 4.

2. Click the Perforated Tube button on the Startup Screen.

3. Choose “SS-5-021(999)052” from the Find Project drop down menu.

   **Note:** Example #1 must be completed before “SS-5-021(999)052” will appear in the list.

4. Click on the New button in the Records section of the Home tab or press the button on the bottom of the screen next to the record number.

5. In the Sta/RP field, type in “209+05.”

6. In the Sta Dir drop down menu, choose “Lt.”

7. Type “D & D” in the Sign No field.

8. Type “2” in the Group No field and press Enter.

9. Click Yes to add the group to the list.

10. Type “ND Hwy 21” in the group description dialog box.

11. Choose “Variable Length Sign” in the Sign Type box.

12. Enter “120” in the Sign Width field.

13. Enter “48” in the Sign Height field.

14. The Design Area field should automatically change to “40.00” (if not enter “40”.)
15. In the _# of Reset Signs_ field, enter a “1.”

16. In the _Location_ box, select “Ditch/Shoulder.”

17. Select “New Post” in the _Support Info_ box.

18. We will be using the _Zero Pavement Depth_ method to determine the pavement thickness for this sign. Enter “3” in the _Pavement Depth_ field (0” of pavement + 3” buffer.)

19. Type “60” in the _Vertical Clearance_ field.

20. The _Graded Width_ is taken from the highest point of the driving lane pertaining to the sign. Because this is a two lane two-way roadway, the left lane is the only lane that applies to the sign. Therefore, the highest point in the driving lane will be at the center of the roadway. (See the Data Input Screen section on page 30 for more information.)

\[
[12’ (driving lane) + 10’ (shoulder) + 0’ (shoulder to Point A)] \times 2 = 44’ = 528”
\]

Enter “528” in the _Graded Width_ field.

21. The _Graded Shldr to Sign_ is therefore the distance from Point A to the edge of the sign.

\[
24’ – 10’ (shoulder) – 0’ (shoulder to Point A) = 14’ = 168”
\]

Enter “168” in the _Graded Shldr to Sign_ field.

22. The _Inslope_ starts at Point A and because the slough on the pavement does not match the adjacent slope rate, the inslope ends at the bottom of the slough. Place a check in the _Inslope_ box and enter “30” (2.5’ x 12) in the _Distance_ field and “6” (width of slough, 30” / height of slough, 5”) in the _Rate_ field.

23. The _Secondary Slope_ starts at the bottom of the slough and ends where the 8:1 slope and the 6:1 slope intersect. Place a check in the _Secondary Slope_ box and enter “90” (7.5’ x 12) in the _Distance_ field and “8” in the _Rate_ field.

24. We still have not gotten out to the end of the sign, so we still need to input more slope information. We cannot use the _Bottom of Ditch_ slope because the next slope in our cross section is not flat, so we will use the _Back Slope_ as the next slope. Place a check in the _Back Slope_ box and enter “216” (18’ x 12) in the _Distance_ field and “6” in the _Rate_ field. In the _Slope_ box, choose “Down.”

25. Choose “Current Sign” in the _Calculate_ box and click the _Calculate_ button. The screen should look similar to the shown in Figure 24.
Figure 24 – Perforated Tube Example #2 Data Input Screen
Example #3 – Four Lane Divided Highway on a Curve

In this example, a new route marker assembly will be installed along the roadway. The roadway is a rural four lane divided highway on a curve. This sign will be added to the project started in Example #1 – Two Lane Two-Way Roadway on a Curve. This sign is in segment one of the survey line.

![Diagram of Perforated Tube Example #3 Cross Section]

Figure 25 – Perforated Tube Example #3 Cross Section

1. Launch the Sign Calculator (see Launching the Database on page 4.) If you are still in the Perforated Tube Calculator, go to step 4.

2. Click the Perforated Tube button on the Startup Screen.

3. Choose “SS-5-021(999)052” from the Find Project drop down menu.

   **Note:** Example #1 must be completed before “SS-5-021(999)052” will appear in the list.

4. Click on the New button in the Records section of the Home tab or press the button on the bottom of the screen next to the record number.

5. In the Sta/RP field, type in “82+55” (use a space as a place holder to keep the digits lined up.)

6. In the Sta Dir drop down menu, choose “Rt.”

7. Type “S.A.A” in the Sign No field.

8. Type “2” in the Group No field and press Enter.

9. Choose “Non Standard Sign” in the Sign Type box.

10. Enter “24” in the Sign Width field.

11. Enter “89” in the Sign Height field.

13. In the Sign Material box, put a check by “Hi Int (3A) Flat Sht” box.

14. Enter “14.19” in the Pay Area field for “Hi Int (3A) Flat Sht.”

15. In the Location box, select “Ditch/Shoulder.”


17. We will be using the Arbitrary Pavement Depth method to determine the pavement thickness for this sign. Enter “14” in the Pavement Depth field (8” of base + 3” of pavement + 3” buffer.)

18. Type “60” in the Vertical Clearance field.

19. The Graded Width is taken from the highest point of the driving lane pertaining to the sign. Because this is a four lane divided highway, both lanes apply to the sign. Therefore, the highest point in the driving lane will be at the left edge of the left driving lane. (See the Data Input Screen section on page 30 for more information.)

\[12’ \text{ (driving lane)} + 8’ \text{ (shoulder)} + 5’ \text{ (shoulder to Point A)} \times 2 = 50’ = 600”\]

Enter “600” in the Graded Width field.

20. The Graded Shldr to Sign is therefore the distance from Point A to the edge of the sign.

\[22’ – 8’ \text{ (shoulder)} – 5’ \text{ (shoulder to Point A)} = 9’ = 108”\]

Enter “36” in the Graded Shldr to Sign field.

21. The Inslope starts at Point A. Place a check in the Inslope box and enter “288” in the Distance field and “6” in the Rate field.

22. Choose “Current Sign” in the Calculate box and click the Calculate button. The screen should look similar to the shown in Figure 26.
Figure 26 – Perforated Tube Example #3 Data Input Screen
The Project Book is the tabulated results of the calculations from your input data in a user friendly format that can be viewed on the screen or printed as plan sheets. You can launch the Project Book by clicking the Project Book button from the Data Input screen. The screen should look similar to the one shown in Figure 27.

### Parts of the Project Book

1. The Project Number is displayed as it was typed into the Project # field on the Data Input screen.

2. The signs are listed by their Station/Reference Point. Choose from ascending or descending order in the Sort Stations box on the Data Input screen.

3. The Sign No is displayed as it was typed into the Sign No field on the Data Input screen.

4. The Assembly Number is displayed as it was typed into the Assembly Number field on the Data Input screen.

5. The quantity of sign material is shown in this column.
6. The length of perforated tube calculated by the program is displayed here.

7. The calculated size of the perforated tube is displayed here.

8. The maximum post length for the supports is shown here.

9. The required length of perforated tube sleeves that was calculated by the program is displayed here.

10. The calculated size of the perforated tube sleeve is displayed here.

11. The quantity of anchors is displayed in this column.

12. The length of each anchor is shown here.

13. The size of the anchor is shown here.

14. aThe number of locations where signs are to be reset is displayed here.

15. The number of sign supports to be reset is displayed here.

16. The number of break away bases to be installed is shown here.

17. Comments are displayed as shown in the Reset Info field on the Data Input screen.

18. The signs are broken up into subtotals by using different Group Numbers, on the Data Input screen, to group them together.

19. The totals of all the quantities for an entire project are shown in the Grand Total line.

   **Hint:** To get the total quantity of “Steel Galv Posts-Telescoping Perforated Tube”, add the grand totals of column 6 and column 12.

20. The plan sheet title block is displayed as shown in the Description field on the Data Input screen.

21. The PE seal block displays the electronic distribution statement when that option is selected (see Include Seal? on page 25.)

### Printing the Project Book

Before you print the project book, you have to setup the page layout to ensure that it prints correctly and can be used as a plan sheet.

1. From inside the Project Book screen, open the **Page Setup** dialog box.
2. Select the **Margins** tab and set the margins as shown in Figure 28.

![Figure 28 – Perforated Tube Project Book Margins Setup](image)

3. Select the **Page** tab and set the page settings as shown in Figure 29. The 11 x 17 paper size option may not be available on your printer (it may be called Tabloid or something else.) Choose the paper size that represents an 11 x 17 paper size.

![Figure 29 – Perforated Tube Project Book Page Setup](image)

4. Select the **Columns** tab and set the column settings as shown in Figure 30.

![Figure 30 – Perforated Tube Project Book Columns Setup](image)

5. Click the **OK** button to close and accept the page setup.
6. Click on the **Print** button.

7. Choose the printer you want to send the project book to and click **OK**.
Exporting RTF Files

The Project Books can be exported as a RTF (Rich Text Format) file. Once the Project Book is in this format, it can be opened in Microsoft Word and then pasted into MicroStation.

Creating the RTF File

1. Project Books can be exported by clicking on the Export RTF button in either the Pipe/W-Shape Calculator or the Perforated Tube Calculator Data Input screen.

2. The Project Book preview screen will open and an “Output To” window will ask you where you want to save the file.

3. Set the location where you want the file to be saved.

4. You can change the name of the file or leave it as the default value.

   **Note:** If you change the filename, make sure you have the .rtf extension at the end of the filename.

5. Click **OK** to export the Project Book into a RTF format.
Bringing the RTF File into MicroStation

1. Launch Microsoft Word.

2. Open the RTF file that you exported from the Sign Calculator.

3. Select the data that you want to copy into MicroStation.

   **Note:** You can only do one page at a time. If you have more than one page, repeat the entire process for each page.

4. Click on **Copy** in the **Clipboard** section of the **Home** tab.

5. Launch MicroStation and open the file you want to paste the data into.

6. Click on **Edit => Paste** on the menu bar in MicroStation.

7. Click on the screen in your design file where you want the first corner of your data to be. A rectangle will follow your cursor to show you where the data will be placed.

8. Select the second corner of the rectangle by clicking on the screen when you have the rectangle where you want it.

9. Place a plan sheet border cell around the data you just pasted.

   **Note:** A 1:1”-0” border will fit the information.

10. Add horizontal lines under the column headings and to separate the subtotals and totals.

    A Microsoft Word window should take over the screen. The data you just placed in MicroStation is now linked to Microsoft Word.

    If you want to make any changes to the data in MicroStation, you make the changes in the Microsoft Word screen. After you have made your changes, click on **File => Save** on the Microsoft Word menu bar and the data will automatically be updated in MicroStation. Close Microsoft Word when you’re done making changes.

**DO NOT USE THE DROP ELEMENT TOOL IN MICROSTATION ON THE IMPORTED DATA!** IF THE DATA IS DROPPED, THE LINK WILL NO LONGER WORK!

**Hint:** You need to have the Arial true type font installed in the MicroStation font library to get the data to look right.
Editing Project Book Data in MicroStation

Once the Project Book data has been imported into MicroStation, the data can be edited at anytime. This section only deals with making minor changes to the data. If you added more sign entries or made extensive changes to your input data in the Sign Calculator, you should delete the data in MicroStation and import it again (see Creating the RTF File and Bringing the RTF File into MicroStation sections above.)

1. Launch MicroStation and open the file containing the Project Book data.
2. Turn the Graphic Group lock on. Click on Settings => Locks and make sure there is a check mark by Graphic Group.
3. Using the Element Selection tool, click on the Project Book data.
4. Click on Edit => Microsoft Word Document => Edit the menu bar.
5. A Microsoft Word window should take over the screen.
6. Make the necessary changes to the data.
7. After you have made your changes, click on File => Save on the menu bar.
Import/Export Project Tables

Updating the Sign Calculator Program

Occasionally, the Sign Calculator database may be updated. You should be able to export your project data from your current version of the database and import into the new version.

1. Launch your current version of the Sign Calculator program (see the Launching the Database section on page 4.)

2. Click the Import/Export Projects button to launch the Import/Export Projects dialog box (see Figure 32.)

   ![Import/Export Projects Dialog Box](image)


4. Click the Export button.

5. Choose the folder where you want to export your project data and click OK.

6. Click OK to continue.

7. Close the Sign Calculator database.

8. Download the latest version of the Sign Calculator database from the internet. See the Support section on page 52 for the web address for updates.

9. Install the new version of the Sign Calculator database (see the Installation section on page 2.)

   **Warning:** Before deleting the old Sign Calculator program, make sure that the new program accepts all the old project data.

10. Launch the new version of the Sign Calculator program.
11. Click the **Import/Export Projects** button to launch the Import/Export Projects dialog box.


13. Click the **Import** button.

14. Click **Yes** to continue importing the project data.

15. Choose the folder where you exported your project data. The file you will be importing is called “Projects.txt.”

   **Note:** The file will not show up in the “Browse for Folder” window. If you forgot where you put the file you will have to find it using Windows Explorer or My Computer.

16. Click **OK** to continue.

17. Click **OK** to complete the update.
Support

Internet

Updates to the Standards Tables in the Sign Calculator database and new versions of the Sign Calculator program can be found on the North Dakota Department of Transportation’s web site, https://www.dot.nd.gov/. Click on the Manuals and Publications link and then click on the Sign Calculator link.

E-mail

Questions and comments can be e-mailed to dotndsigns@nd.gov.
Appendix A – Typical Ditch Sections

Figure 33 shows the three different methods that can be used to enter the pavement depth and graded roadway information into the sign program.

**Actual Pavement Depth Method**

**Arbitrary Pavement Depth Method**

**Zero Pavement Depth Method**

NOTES:
1. The inslope may go to the R/W
2. There may or may not be an inslope
3. There may or may not be a secondary slope
4. There may or may not be a ditch bottom
5. There may or may not be a back slope
6. The back slope may slope up or down (DO NOT USE MINUSES)
7. There may or may not be original ground
8. The original ground may be flat or slope up or down (DO NOT USE MINUSES)

Figure 33 – Pavement Depth Methods
Appendix A – Typical Ditch Sections

Figure 34 shows how the sign program looks at a curb and gutter section.

![Figure 34 – Curb and Gutter Section](image)

The following figures show different combinations that can be used for entering the cross section information into the sign program. These are only a few of the combinations that can be used. The slopes can be combined in just about anyway. The only restriction is that they must be in the order they appear in the list on the Data Input Sheet (i.e. the secondary slope cannot be before an inslope, the back slope cannot be before the ditch bottom, etc.)

![Figure 35 – Inslope only](image)

![Figure 36 – Inslope with Secondary Slope](image)

![Figure 37 – Inslope with Secondary Slope and Upward Back Slope](image)

![Figure 38 – Inslope with Secondary Slope and Downward Back Slope](image)
Appendix A – Typical Ditch Sections

Figure 39 – Inslope with Secondary Slope, Downward Back Slope, and Upward Original Ground

Figure 40 – Inslope with Secondary Slope, Downward Back Slope, and Downward Original Ground

Figure 41 – Inslope with Ditch Bottom

Figure 42 – Inslope with Ditch Bottom and Upward Back Slope

Figure 43 – Inslope with Ditch Bottom and Downward Back Slope
Appendix A – Typical Ditch Sections

Figure 44 – Inslope with Ditch Bottom, Upward Back Slope, and Upward Original Ground

Figure 45 – Inslope with Ditch Bottom, Upward Back Slope, and Downward Original Ground

Figure 46 – Inslope with Upward Back Slope

Figure 47 – Inslope with Upward Back Slope and Upward Original Ground

Figure 48 – Inslope with Upward Back Slope and Downward Original Ground
The Perforated Tube Sign Calculator program first calculates the size of the post based on a single post and then it calculates the size and number of posts based on the total cross sectional area of the posts. The following table shows what order the program uses to calculate the posts:

<table>
<thead>
<tr>
<th>Sequence #</th>
<th>Post Size</th>
<th>Sleeve Size</th>
<th># of Posts</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>2” x 2” 12ga</td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>2</td>
<td>2.25” x 2.25” 12ga</td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>3</td>
<td>2.5” x 2.5” 12ga</td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>4</td>
<td>2.5” x 2.5” 10ga</td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>5</td>
<td>2.25” x 2.25” 12ga</td>
<td>2” x 2” 12ga</td>
<td>1</td>
</tr>
<tr>
<td>6</td>
<td>2.5” x 2.5” 12ga</td>
<td>2.25” x 2.25” 12ga</td>
<td>1</td>
</tr>
<tr>
<td>7</td>
<td>2.5” x 2.5” 10ga</td>
<td>2.19” x 2.19” 10ga</td>
<td>1</td>
</tr>
<tr>
<td>8</td>
<td>2” x 2” 12ga</td>
<td></td>
<td>2</td>
</tr>
<tr>
<td>9</td>
<td>2.25” x 2.25” 12ga</td>
<td></td>
<td>2</td>
</tr>
<tr>
<td>10</td>
<td>2.5” x 2.5” 12ga</td>
<td></td>
<td>2</td>
</tr>
<tr>
<td>11</td>
<td>2.5” x 2.5” 10ga</td>
<td></td>
<td>2</td>
</tr>
<tr>
<td>12</td>
<td>2.25” x 2.25” 12ga</td>
<td>2” x 2” 12ga</td>
<td>2</td>
</tr>
<tr>
<td>13</td>
<td>2.5” x 2.5” 12ga</td>
<td></td>
<td>3</td>
</tr>
<tr>
<td>14</td>
<td>2.5” x 2.5” 12ga</td>
<td>2.25” x 2.25” 12ga</td>
<td>2</td>
</tr>
<tr>
<td>15</td>
<td>2.5” x 2.5” 10ga</td>
<td></td>
<td>3</td>
</tr>
<tr>
<td>16</td>
<td>2.5” x 2.5” 12ga</td>
<td></td>
<td>4</td>
</tr>
<tr>
<td>17</td>
<td>2.25” x 2.25” 12ga</td>
<td>2” x 2” 12ga</td>
<td>3</td>
</tr>
<tr>
<td>18</td>
<td>2.5” x 2.5” 10ga</td>
<td>2.19” x 2.19” 10ga</td>
<td>2</td>
</tr>
<tr>
<td>19</td>
<td>2.5” x 2.5” 12ga</td>
<td></td>
<td>4</td>
</tr>
<tr>
<td>20</td>
<td>2.5” x 2.5” 12ga</td>
<td>2.25” x 2.25” 12ga</td>
<td>3</td>
</tr>
<tr>
<td>21</td>
<td>2.25” x 2.25” 12ga</td>
<td>2” x 2” 12ga</td>
<td>4</td>
</tr>
<tr>
<td>22</td>
<td>2.5” x 2.5” 10ga</td>
<td>2.19” x 2.19” 10ga</td>
<td>3</td>
</tr>
<tr>
<td>23</td>
<td>2.5” x 2.5” 12ga</td>
<td>2.25” x 2.25” 12ga</td>
<td>4</td>
</tr>
<tr>
<td>24</td>
<td>2.5” x 2.5” 10ga</td>
<td>2.19” x 2.19” 10ga</td>
<td>4</td>
</tr>
</tbody>
</table>
Appendix C – Standards Maintenance

The Standards Maintenance area is restricted and can only be updated by an authorized person in the North Dakota Department of Transportation, Design Division, Traffic Safety Section.

Startup Screen

To enter the Standards Maintenance area, launch the Sign Calculator program. Log in using a user id and password that has the required level of security. Click the Standards Maintenance button and the dialog box shown in Figure 49 will appear. The dialog box also shows when each table was last updated.

Figure 49 - Standards Maintenance Password Window

To edit the Standards tables, press the Click to Enter button. The dialog box shown in Figure 50 will appear.

Figure 50 – Standards Maintenance Window

This area is broken up into seven tables. These tables give the Sign Calculator program information on post sizes, the order to calculate the posts, and sign assemblies.

1. **Pipe**: Button that launches the dialog box used to add/edit the pipe sizes the program uses.
2. **W-Shape**: Button that launches the dialog box used to add/edit the w-shape sizes the program uses.

3. **Maintain Assembly Standards**: Button that launches the dialog box used to add/edit the standard assemblies found on ND Standard Drawings D-754-26–45 & 51–75. These assemblies are used in the **Assembly Number** field in the Perforated Tube Data Input screen (see Data Input Screen section on page 28.)

4. **Perforated Tube**: Button that launches the dialog box used to add/edit the perforated tube sizes the program uses.

5. **Perforated Tube Sequence**: Button that launches the dialog box used to add/edit the sequence that the program uses to calculate perforated tubes sizes.

6. **Variable Sign Width**: Button that launches the dialog box used used to add/edit the width of the variable length signs found on ND Standard Drawings D-754-47–50. These widths are used by the Variable Length Type signs (see Data Input Screen section on page 28.)

7. **Variable Sign Height**: Button that launches the dialog box used used to add/edit the height of the variable length signs found on ND Standard Drawings D-754-47–50. These widths are used by the Variable Length Type signs (see Data Input Screen section on page 28.)

8. **Import/Export Standards**: Button that allows the user to upload/download standards tables into the database. From here you are able to upload new standard assemblies or support sizes into your existing database. You can also download data from your existing standards so that it can be imported into a newer version of the database. See the Support section on page 52 for the web address for updates.
Pipe Sizes

This table contains data on the different sizes of pipes that the program uses. To edit the existing pipes or to add a new pipe size, click the Pipe button in the Standards Maintenance window (see Figure 50 on page 58.) The following dialog box will appear:

![Pipe Standards Maintenance Dialog Box]

Figure 51 – Pipe Standards Maintenance Dialog Box

1. **Record Selection Button**: Click on this button to select the entire record.

   **Hint**: To delete a record, click on the Record Selection button and press the Delete key.

2. **Sequence Num**: The Sign Calculator program uses this field to determine what order it should use to determine the size of the pipe support.

3. **Nominal Diameter**: Enter in the nominal diameter of the pipe.

4. **Radius**: This is the radius of from the center of the pipe to the mid-thickness of the wall in inches.

5. **Thickness**: Enter in the wall thickness of the pipe in inches.

6. **Wt_Ft**: Enter in the weight in pounds per foot of the pipe.

7. **Section Modulus**: Enter in the elastic section modulus of the pipe in cubic inches.

8. **Area**: Enter in the cross sectional area of the pipe in square inches.

9. **R_t**: This is the ratio of the radius to the wall thickness (#4 divided by #5.)

10. **Fy_E(R_t)**: This is the minimum yield stress divided by the modulus of elasticity multiplied by the ratio of the radius to the wall thickness. \( (F_Y/E)*(r/t) \)

11. **Fdn Dia. (in.)**: Enter in the diameter of the concrete foundation in inches.

12. **Fdn Dia. (ft.)**: Enter in the diameter of the concrete foundation in feet.
Appendix C – Standards Maintenance

W-Shape Sizes

This table contains data on the different sizes of w-shape supports that the program uses. To edit the existing w-shapes or to add a new w-shape size, click the **W-Shape** button in the **Standards Maintenance** window (see Figure 50 on page 58.) The following dialog box will appear:

![Figure 52 – W-Shape Standards Maintenance Dialog Box](image)

1. **Record Selection Button**: Click on this button to select the entire record.

   **Hint**: To delete a record, click on the **Record Selection** button and press the **Delete** key.

2. **Sequence Num**: The Sign Calculator program uses this field to determine what order it should use to determine the size of the w-shape support.

3. **Nominal Size**: Enter in the nominal size of the w-shape support.

4. **Area**: Enter in the cross sectional area of the w-shape in square inches.

5. **Web Depth**: Enter in the depth of the web of the w-shape in inches.

6. **Web Thickness**: Enter in the web thickness of the w-shape in inches.

7. **Flange Width**: Enter in the width of the flange of the w-shape in inches.

8. **Flange Thickness**: Enter in the flange thickness of the w-shape in inches.

9. **Section Modulus**: Enter in the elastic section modulus of the w-shape in cubic inches.

10. **W/t**: This is the ratio of the flange width to the flange thickness (#7 divided by #8.)

11. **D/t**: This is the ratio of the web depth to the web thickness (#5 divided by #6.)
Appendix C – Standards Maintenance

**Standard Assemblies**

This table contains data about the standard assemblies found on ND Standard Drawings D-754-26–45 & 51–75. These assemblies are used in the **Assembly Number** field in the Perforated Tube Data Input screen (see Data Input Screen section on page 28.)

To edit the existing assemblies or to add a new assemblies, click the **Maintain Assembly Standards** button in the **Standards Maintenance** window (see Figure 50 on page 58.) The following dialog box will appear:

![Figure 53 – Standard Assembly Maintenance Dialog Box](image)

1. **Record Selection Button**: Click on this button to select the entire record.
   
   **Hint**: To delete a record, click on the **Record Selection** button and press the **Delete** key.

2. **Find Assembly**: Choose the active assembly to display from the drop down menu.

3. **Assem Num**: Enter in the number assigned to the assembly.

4. **Width**: Enter in the total width of the assembly in inches.

5. **Height**: Enter in the total height of the assembly in inches.

6. **3A Sign Only**: Place a check mark in this box if the sign will always be made of 3A reflective sheeting.

7. **Pay Area**: Enter in the total pay area of the assembly in square feet.
8. Design Area: Enter in the design area to be used to calculate wind load for the assembly in square feet.

9. Min Posts: Enter in the minimum number of posts to be used for calculations on this assembly.

10. Max Posts: Enter in the maximum number of posts to be used for calculations on this assembly.

11. Over Hang1: Enter the distance, in inches, from the edge of the sign to the post for a one post assembly (this will be one half the sign width.)

12. Post Space1: This will always be zero for one post assemblies.

13. Top Of Post1: Enter the distance, in inches, from the top of the post to the top of the assembly for a one post assembly.

14. Over Hang2: Enter the distance, in inches, from the edge of the sign to the first post of the assembly for a two post assembly. The first post is the left post in the assembly.

15. Post Space2: Enter in the distance between the posts in inches for a two post assembly.

16. Top Of Post2: Enter the distance, in inches, from the top of the highest post to the top of the assembly for a two post assembly.

17. Post Adj2: If one of the posts is shorter than the other, enter the post number of the shorter post here for a two post assembly. The posts are numbered from left to right, starting with one.

18. Adj Amt2: If one of the posts is shorter than the other, enter the amount (as a negative number) that the post is shorter in inches for a two post assembly.

19. Over Hang3: Enter the distance, in inches, from the edge of the sign to the first post of the assembly for a three post assembly. The first post is the left most post of the assembly.

20. Post Space3: Enter in the distance between the posts in inches for a three post assembly. If the post spacing between posts 1 & 2 is different than the spacing between posts 2 & 3, use the average.

21. Top Of Post3: Enter the distance, in inches, from the top of the highest post to the top of the assembly for a three post assembly.

22. Post Adj3: If one or more of the posts in a three post assembly is shorter than the others, enter the post number(s) of the shorter post(s) here, putting a comma and
Appendix C – Standards Maintenance

no space between the post numbers (i.e. 1,3.) The posts are numbered from left to right, starting with one.

23. **Adj Amt3**: If one or more of the posts in a three post assembly is shorter than the others, enter the amount (as a negative number) that the posts are shorter than the highest post. If there is more than one post the amounts should be separated with a comma and no space. For example, post 2 is the highest post in the assembly. Post 1 is 12 inches shorter than post 2 and post 3 is 15 inches shorter than post 2. You would enter “-12,-15” in the field.

    **Warning**: The Post Adj3 field and the Adj Amt3 field **MUST** have the same number of entries. I.e. if posts 1 & 3 shown in the Post Adj3 field, then there should be two adjustment amounts in the Adj Amt3 field, even if they are the same amount.

24. **Over Hang4**: Enter the distance, in inches, from the edge of the sign to the first post of the assembly for a four post assembly. The first post is the left most post of the assembly.

25. **Post Space4**: Enter in the distance between the posts in inches for a four post assembly. If the post spacing between posts 1 & 2 is different than the spacing between posts 2 & 3 or posts 3 & 4, use the average of all three.

26. **Top Of Post4**: Enter the distance, in inches, from the top of the highest post to the top of the assembly for a four post assembly.

27. **Post Adj4**: If one or more of the posts in a four post assembly is shorter than the others, enter the post number(s) of the shorter post(s) here, putting a comma and no space between the post numbers (i.e. 1,3.) The posts are numbered from left to right, starting with one.

28. **Adj Amt4**: If one or more of the posts in a four post assembly is shorter than the others, enter the amount (as a negative number) that the posts are shorter than the highest post. If there is more than one post the amounts should be separated with a comma and no space. For example, posts 2 & 4 are the highest posts in the assembly. Post 1 is 12 inches shorter than posts 2 & 4 and post 3 is 15 inches shorter than posts 2 & 4. You would enter “-12,-15” in the field.

    **Warning**: The Post Adj4 field and the Adj Amt4 field **MUST** have the same number of entries. I.e. if posts 1 & 3 shown in the Post Adj4 field, then there should be two adjustment amounts in the Adj Amt4 field, even if they are the same amount.
**Perforated Tube Sizes**

This table contains data on the different sizes of perforated tube supports that the program uses. To edit the existing perforated tubes or to add a new perforated tube size, click the Perforated Tube button in the Standards Maintenance window (see Figure 50 on page 58.) The following dialog box will appear:

![Perforated Tube Standards](image)

**Figure 54 – Perforated Tube Maintenance Dialog Box**

1. **Record Selection Button**: Click on this button to select the entire record.
   
   **Hint**: To delete a record, click on the Record Selection button and press the Delete key.

2. **Sequence Num**: This is an unique arbitrary number assigned to the perforated tube.

3. **Nominal**: Enter in the nominal size of the perforated tube support as you want it to appear on the Project Book (see Figure 27 on page 43.)

4. **Gauge**: Enter in the gauge of the perforated tube.

5. **Thickness**: Enter in the wall thickness of perforated tube in inches. If the perforated tube has a sleeve, enter in the total wall thickness of both. Use the manufacturer’s value.

6. **Wt_Ft**: Enter in the weight of the perforated tube in pounds per foot. If the perforated tube has a sleeve, enter a zero. Use the manufacturer’s value.

7. **Section Modulus**: Enter in the elastic section modulus of the perforated tube in cubic inches. Use the manufacturer’s value. If the perforated tube has a sleeve,
enter in the elastic section modulus of the cross section of the support with the sleeve.

8. **Area**: Enter the cross sectional area of the perforated tube in square inches. If the perforated tube has a sleeve, enter a zero.

9. **Radius**: The radius is the distance from the center of the perforated tube to the mid-thickness of the wall in inches. If the perforated tube has a sleeve, the radius is the distance from the center of the perforated tube to the middle of the total wall thickness.

10. **n**: This is the ratio of the inside-corner radius to wall thickness, \(n'\). For more information, refer to Appendix B of the AASHTO Standard Specifications for Structural Supports for Highway Signs, Luminaires and Traffic Signals. If the perforated tube has a sleeve, enter a zero.

11. **t_R**: This is the ratio of the wall thickness to the radius (\#5 divided by \#9.) If the perforated tube has a sleeve, enter a zero.

12. **Kt**: This is the stress concentration factor for multisided tubular shapes, \(k_t\). For more information, refer to Appendix B of the AASHTO Standard Specifications for Structural Supports for Highway Signs, Luminaires and Traffic Signals. If the perforated tube has a sleeve, enter a zero.

13. **Rt**: This can be left blank. This is a variable that was carried over from the old sign program and really has no use in this program.

14. **Anchor Size**: Enter in the nominal size of the anchor as you want it to appear on the Project Book (see Figure 27 on page 43.) The anchor size can be found on ND Standard Drawing D-754-24.

15. **Sleeve**: Place a check in this box if the perforated tube has an anchor.

16. **Sleeve Size**: Enter in the nominal size of the sleeve as you want it to appear on the Project Book (see Figure 27 on page 43.)

17. **Section Modulus of outer Tube**: Enter in the elastic section modulus of just the perforated tube in cubic inches. Do not include the section modulus of the sleeve.

18. **Pipe is used in which Scenario?**: Place a check in the box next to the scenario you want to be used by the program to calculate post sizes. If you place a check by **Post 1**, **Post 2**, and **Post 3**, the program will not use this post size for calculations if the sign requires four posts. The number of posts available for each size of perforated tube can be found on ND Standard Drawing D-754-24.

19. **Slip Base is used in which Scenario?**: Place a check in the box next to the scenario you want to add a slip base to. If you place a check by **Post 3**, the program will add a slip base if the sign is mounted on three of this type of
perforated tubes. ND Standard Drawing D-754-24 shows when a slip base should be used.
Perforated Tube Sequence

This table contains data on what order the Sign Calculator program uses to calculate the size of the perforated tube. For a detailed list of the sequence, see Appendix B – Order of Calculations for Perforated Tube on page 57. To edit the existing sequence or to add a new perforated tube to the sequence, click the Perforated Tube Sequence button in the Standards Maintenance window (see Figure 50 on page 58.) The following dialog box will appear:

![Perforated Tube Sequence Dialog Box](image)

Figure 55 – Perforated Tube Sequence Dialog Box

1. **Record Selection Button**: Click on this button to select the entire record.

   **Hint**: To delete a record, click on the Record Selection button and press the Delete key.

2. **Sequence Number**: The Sign Calculator program uses this field to determine what order it should use to determine the size of the perforated tube.

3. **Perf Tube Num**: Enter in the number that was assigned to the perforated tube in the Perforated Tube table (see Sequence Num in the Perforated Tube Sizes section on page 65.)

4. **Number of Posts**: Enter in the number of posts to be used when calculating this size of post for this sequence number.
Variable Sign Width

This table contains data used by the Variable Length Sign Type in the Perforated Tube Sign Calculator program (see the Data Input Screen section of the Perforated Tube Calculator on page 28.) The variable sign width, post spacing, and sign overhang used by this table can be found on ND Standard Drawings D-754-26-47–50.

To edit an existing variable sign size or to add a new variable sign size, click the Variable Sign Width button in the Standards Maintenance window (see Figure 50 on page 58.) The following dialog box will appear:

Figure 56 – Variable Sign Width Dialog Box

1. **Record Selection Button**: Click on this button to select the entire record.
   
   **Hint**: To delete a record, click on the Record Selection button and press the Delete key.

2. **Width**: Enter in the variable sign width in inches.

3. **Find Width**: Choose the variable sign width you want to be displayed as the active record from the drop down menu.

4. **Over Hang 2**: Enter the distance, in inches, from the edge of the sign to the first post of the assembly for a two post assembly. The first post is the left post.

5. **Over Hang 3**: Enter the distance, in inches, from the edge of the sign to the first post of the assembly for a three post assembly. The first post is the left most post of the assembly.

6. **Over Hang 4**: Enter the distance, in inches, from the edge of the sign to the first post of the assembly for a four post assembly. The first post is the left most post of the assembly.

7. **Post Space 2**: Enter in the distance between the posts, in inches, for a two post assembly.

8. **Post Space 3**: Enter in the distance between the posts, in inches, for a three post assembly.
9. **Post Space 4**: Enter in the distance between the posts, in inches, for a four post assembly.
Variable Sign Height

This table contains data used by the Variable Length Sign Type in the Perforated Tube Sign Calculator program (see the Data Input Screen section of the Perforated Tube Calculator on page 28.) The variable sign height used by this table can be found on ND Standard Drawings D-754-26-47–50.

To edit an existing variable sign size or to add a new variable sign size, click the Variable Sign Height button in the Standards Maintenance window (see Figure 50 on page 58.) The following dialog box will appear:

1. **Record Selection Button**: Click on this button to select the entire record.
   - **Hint**: To delete a record, click on the Record Selection button and press the Delete key.

2. **Height**: Enter in the variable sign height in inches.

3. **Top Of Post**: Enter the distance from the top of the sign to the top of the post in inches.
Updating the Standards Tables

Once the Standards Tables are updated, they can be exported from your current database and then imported into a newer version of the database.

1. Click the **Import/Export Standards** button to launch the Import/Export Standards dialog box (see Figure 58.)

![Import/Export Standards Dialog Box](image)

Figure 58 – Import/Export Standards Dialog Box


3. Click the **Export** button.

4. Choose the folder where you want to export your project data and click **OK**.

5. Click **OK** to continue.


7. Launch the Sign Calculator database that you want to import the Standards Tables into.

8. Click the **Import/Export Standards** button to launch the Import/Export Standards dialog box.


10. Click the **Import** button.

   **Note:** By doing this, you will be replacing all the Standards Tables in your database with the ones that you are importing. This cannot be undone!

11. Click **Yes** to continue importing the Standards Tables.

12. Choose the folder where you exported the Standards Tables file. The file you will be importing is called “Standards.txt.”
Note: The file will not show up in the “Browse for Folder” window. If you forgot where you put the file you will have to find it using Windows Explorer or My Computer.

13. Click **OK** to continue.

14. Click **OK** to complete the update.
Glossary

active project/record: the project/record that is currently being displayed on the screen

assembly: a collection of signs, stringers, and supports that are fit together in a specific way

aux: abbreviation for auxiliary sign (see auxiliary sign)

auxiliary sign: sign that is supplemental to the main sign (i.e. advisory speed limit)

back slope: slope that generally follows the ditch bottom, but can follow the inslope or secondary slope in a V ditch section

bottom of ditch: flat area in the ditch section

break away base: joint at the bottom of the supports that will shear away when struck by a vehicle

concrete foundation: cylindrical concrete formation installed in the ground that holds the stub post

context menu: menu that appears when something is clicked with the right mouse button

cross section: a cutting of a roadway made at a right angle to the centerline of the roadway

ctrl: control key on a computer keyboard

data input screen: screen used to input specific data to be used by the Sign Calculator program to calculate the size and length of the sign support

database: a large collection of data organized for rapid search, viewing & printing, and for performing calculations

design area: the surface area of the sign(s), from one particular side, that when hit by the wind will produce the largest moment on the sign support

designer: the person entering the information into the database

desktop: the on-screen work area on which windows, icons, menus, and dialog boxes appear

dia: abbreviation for diameter
<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>download</td>
<td>the transfer of data from the database to a text file; to transfer data from the internet to the memory of a local computer</td>
</tr>
<tr>
<td>drop down menu</td>
<td>list of available options that appears when the button with the downward pointing triangle directly to the right of the field is pressed</td>
</tr>
<tr>
<td>driving lane</td>
<td>the portion of the roadway for the movement of vehicles, exclusive of shoulders and consisting of one lane of travel</td>
</tr>
<tr>
<td>elastic section modulus</td>
<td>the ratio of moment of inertia to the largest distance from the neutral surface to the neutral axis</td>
</tr>
<tr>
<td>EXIT sign panel</td>
<td>sign containing the word “EXIT” and the exit number; at the top of the main sign, usually on the right</td>
</tr>
<tr>
<td>export</td>
<td>the transfer of data from the database to a text file</td>
</tr>
<tr>
<td>fdn</td>
<td>abbreviation for foundation</td>
</tr>
<tr>
<td>field</td>
<td>box where data can be entered by typing or choosing data from a list</td>
</tr>
<tr>
<td>fuse joint</td>
<td>the joint created in the pipe or w-shape supports at the bottom of the sign that will act like a hinge when struck by a vehicle</td>
</tr>
<tr>
<td>gore</td>
<td>the small, usually triangular, piece of land just beyond the point where the exit ramp leaves the main roadway</td>
</tr>
<tr>
<td>graded width</td>
<td>double the distance, in inches, from the highest point in the driving lane(s), from which the sign can be viewed, to the point where the line representing the bottom of the pavement depth intersects the inslope</td>
</tr>
<tr>
<td>groups</td>
<td>a number of database records assembled together or having some unifying relationship</td>
</tr>
<tr>
<td>H-pile footing</td>
<td>piling that is driven into the ground to support the W-shape supports</td>
</tr>
<tr>
<td>icon</td>
<td>a pictorial representation of a program or file</td>
</tr>
<tr>
<td>import</td>
<td>the transfer of data from a text file to the database</td>
</tr>
<tr>
<td>inslope</td>
<td>the slope that is adjacent to the roadway and generally runs down and away</td>
</tr>
<tr>
<td>max post len</td>
<td>see maximum post length</td>
</tr>
<tr>
<td>Term</td>
<td>Definition</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>maximum post length:</td>
<td>the maximum length the support can be before a larger support is required</td>
</tr>
<tr>
<td>multi-directional break away base:</td>
<td>break away base that will shear away when struck by a vehicle from any direction</td>
</tr>
<tr>
<td>NAS:</td>
<td>variable assigned to the sign number or special assembly number in the Pipe/W-shape Calculator</td>
</tr>
<tr>
<td>NDDOT:</td>
<td>North Dakota Department of Transportation</td>
</tr>
<tr>
<td>Notes Report:</td>
<td>report that lists all the errors/warning messages for a project</td>
</tr>
<tr>
<td>offset sign:</td>
<td>signs placed at least 30’ or more from the edge of the driving lane; usually installed with the center of the sign 60’ from the edge of the driving lane</td>
</tr>
<tr>
<td>original ground:</td>
<td>slope after the ditch section, generally it follows the back slope</td>
</tr>
<tr>
<td>over hang:</td>
<td>distance from the edge of the sign to the center of the adjacent post</td>
</tr>
<tr>
<td>pay area:</td>
<td>total surface area of the sign(s); based on type of sign material</td>
</tr>
<tr>
<td>perforated tube sleeve:</td>
<td>perforated tube that is inserted inside the perforated tube support</td>
</tr>
<tr>
<td>perforated tube support:</td>
<td>sign support made from a hollow square tube made from steel and having circular holes punched along all four faces for the entire length of the tube</td>
</tr>
<tr>
<td>perp sign:</td>
<td>see perpendicular sign</td>
</tr>
<tr>
<td>perpendicular sign:</td>
<td>sign installed at a right angle to the main sign</td>
</tr>
<tr>
<td>pipe support:</td>
<td>sign support made from a hollow standard strength steel pipe</td>
</tr>
<tr>
<td>plan revision:</td>
<td>a change made to the plans after authorization of the project (see the ND Department of Transportation Design Manual – Section 1-11 – Plan Revisions and Change Orders)</td>
</tr>
<tr>
<td>plan sheet:</td>
<td>a printed or digital sheet that will be used in a set of plans</td>
</tr>
<tr>
<td>post space:</td>
<td>distance from the center of a post to the center of an adjacent post</td>
</tr>
<tr>
<td>project:</td>
<td>the part of the database that contains all the records for a specific set of data</td>
</tr>
<tr>
<td>Project Book:</td>
<td>sheets containing tabulated data that show not only the size &amp; length of sign supports, but also many other signing pay items (i.e. sign material area, reset signs, reset supports, etc.)</td>
</tr>
</tbody>
</table>
Glossary

**record:** a collection of related items of information treated as a unit

**reference point:** point along a highway that is measured from the beginning of the highway and is expressed as a decimal number to three places (i.e. 15.659)

**reset:** the existing sign or support is removed and is reinstalled in either the same or a different location

**RP:** see reference point

**RTF:** Rich Text Format; ASCII files with special commands to indicate formatting information, such as fonts and margins

**SA:** abbreviation for special assembly (see special assembly number)

**secondary slope:** slope adjacent to the inslope and starts where the slope rate changes

**section modulus:** see elastic section modulus

**sequence number:** number used to determine what order the perforated tube supports are calculated

**shortcut:** a link to any item accessible on your computer or on a network, such as a program, file, or folder

**sign material:** the type of reflective background material used on the sign

**sign summary sheets:** see Project Book

**slip base:** see break away base

**sleeve:** see perforated tube sleeve

**slope rate:** rate at which the slope rises or drops, expressed as the number of horizontally units to one vertical unit

**SN:** abbreviation for sign number

**special assembly number:** number assigned to a assembly that is not a standard assembly

**spreadsheet:** a table of values arranged in rows and columns

**sta:** see station

**standard assembly:** assembly that can be found in the North Dakota Standard Drawings D-704-26–45 & 51–75
Glossary

**station:** point along on a survey line that is expressed as a fraction of 100 ft (i.e. 752 ft = 7+52)

**stub post:** short pipe installed in the concrete foundation or the top portion of the H-pile footing that the supports rest on

**tables:** a systematic arrangement of data usually in rows and columns

**title block:** the bottom right hand corner of the plan sheet that contains the sheet title and the location and/or any details about the sheet

**upload:** the transfer of data from a text file to the database

**variable length sign:** a single sign that has a width between 4’-0” and 20’-0” and a height between 1’-6” and 5’-6”

**W-shape support:** sign support made from structural steel and having two parallel flanges that are connected by a web member (the shape resembles the letter “H”)

Index

Data Input Screen
   Perforated Tube.......................... 24–33
   Pipe/W-Shape .................................. 6–15
Delete Record.............................. 15, 33, 37, 40
Design Area .................. 11, 17, 28, 37, 41, 63
Edit Group Description............... 8, 26
Exporting RTF Files ................... 47–49
Graded Shldr to Sign........ 13, 17, 31, 35, 38, 41
   graded width.............................. 13, 31
   Graded Width............................ 12, 17, 18, 30, 35, 38, 41
Import/Export ............................ 50–51
InPlace Post Type ....................... 13
Input Sheet
   Perforated Tube......................... 25
   Pipe/W-Shape .............................. 7
Notes Report
   Perforated Tube......................... 26, 33
   Pipe/W-Shape .............................. 8, 15, 33
Over Hang.............................. 13, 31, 63, 69
Pavement Depth......................... 12, 30
   Actual .................................... 12, 17, 30, 35
   Arbitrary ............................... 12, 30, 41
   Zero ...................................... 12, 18, 30, 38
Pay Area.............................. 11, 17, 29, 41, 62
   plan revision ........................... 6, 24
Post Space ...................... 13, 31, 63, 69
Project Book
   Perforated Tube......................... 43–46
   Pipe/W-Shape .............................. 20–23
   sign summary ........................... 5, 6, 24
   Sign Type .............................. 10, 17, 28, 35, 37, 40
   Sta/RP ............................. 7, 9, 16, 25, 27, 35, 37, 40
   Startup Screen ......................... 4
   Support .............................. 52
Vertical Clearance 12, 17, 18, 30, 35, 38, 41